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Exorapid-qIC® 

Immunochromatographic kit for  

extracellular vesicles  

(CD9, CD63, CD81 set) 

[Cat.No. :DNT-EXO-K123] 

Instruction Manual 
 

Handling Precautions 

 This product is for research use only.   

 ※Since it is not subject to the Pharmaceuticals and Medical Devices Act, it cannot be

 used for diagnostic purposes. 

 Store in a cool, dark place (4℃) away from heat and humidity. 

 Please pay attention to the following points when using the Imm

unochromatographic Test Strip (Contents No.1). 

 ①Do not use near open flames 

 ②Moisten before disposal 

 ③Avoid storing at room temperature 

 ④Avoid direct sunlight 

 ⑤Avoid impact and friction 

 Dispose of waste liquid and other waste materials in accordance with l

ocal regulations. 

 Wear recommended personal protective equipment (lab coat, safety gla

sses, mask, rubber gloves, etc.).  

 Wash hands thoroughly after handling.  

 Be careful not to inhale dust etc.  

 If the solution gets into your eyes or mouth, immediately rinse thorou

ghly with water for several minutes. If irritation persists, seek medical 

advice. 
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 Introduction 

Before using the Exorapid-qIC® Immunochromatography Kit for Extracellular Vesicles [Cat. 

No. : DNT-EXO-K01, K02, K03], you can use this product (set of products) to determine which 

antibody species are suitable for immunochromatographic detection of your extracellular 

vesicles.  

Different detection between the antibody species coated on the immunochromatographic test 

strip and the antibody species labeled on the gold nanoplates is possible. ［Example: Test 

strip: CD9 antibody, gold nanoplate: CD63 antibody.］ 

 Kit Component  

No. Component 
Quantitiy 

CD9 CD63 CD81 

1 
CD9 antibody coated Immuno

-chromatographic Test strip※1 
7 strips※2 7 strips※2 7 strips※2 

2 

Gold nanoplate labeled 

antibody 

 [lyophilized product] 

1 bottle 

(Equivalent to 

220 µL)※3 

1 bottle 

(Equivalent to 

220 µL)※3 

1 bottle 

(Equivalent to 

220 µL)※3 

3 
Standard substance 

[lyophilized product] 

1 bottle 

(Equivalent to 

105 ng)※4 

1 bottle 

(Equivalent to 

280 ng)※4 

1 bottle 

(Equivalent to 

28 ng)※4 

4 Dilution solution 1 bottle（0.9 mL） 

5 Washing solution 1 bottle（10 mL） 

6 Assay microplate 96 Well １ plate 

7 Instruction manual １ copy 

※1. To distinguish the antibody type, lines are drawn in pencil on the absorbent paper  

(No line: CD9, one line: CD63, two lines: CD81).  

※2. The number of strips are contained about 10% (4 bottles) more as a reserve.   

※3. 6 analyses (180 µL) + 40 µL reserve.  

※4. Dissolve in 140 µL of purified water to prepare a solution with a concentration 

(CD9: 0.75ng/µL, CD63: 2.0ng/µL, CD81 0.20ng/µL).  

 Materials Not Included in the kit 

※5. Pure water, ultrapure water, distilled water, etc. 

 Precautions for use 

Please open the aluminum pouch and remove the freeze-dried product contents and 

Immunochromatographic Test Strips after returning them to room temperature. 

Contents may be attached to the cap or inside wall of the tube. 

Before opening, please remove any dirt by flushing with a tabletop centrifuge. 

Micropipettes Paper towels 

Tabletop mixer (for tubes) 
Microtube  

(recommended volume: 0.5-2.0 mL) 

Tweezers Purified water※5 

Tapes Tabletop Centrifuge 

Immunochromatography measuring device or scanner 

CD9 CD63 CD81 

Ex.) Appearance of test 

strip 
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Step0. Preparation 

Step1. Development of Samples 

Step2. Development of Washing  

solution (1st time) 

Step3. Development of Gold nanoplate labeled antibodies 

Step4. Development of Washing solution (2nd time) 

Analysis 

 
  

1. Setting up the microplate.  

 [Fig.1-(a)] 

☞Placing the lid underneath, can 

slope a plate to make it easier to 

spread samples.  

2. Remove the required number of 

test strips. Do not use any that 

have large pieces of peeling off. 

[Fig.1-(b)] 

Fig.1-(a) Fig.１-(b) 

NG examples 

10 min. 

Later 

Fig.2-(a) Fig.２-(c) Fig.２-(b) 

1. Inject 20 µL of the standard substance (rCD9 

solution) and your sample solution into each well. 

[Fig.2-(a)] 

2. Place the test strip in each well with the absorbent 

paper up.[Fig.2-(b)] 

3. Check that the solution in the wells has 

disappeared. [Fig.2-(c)] 

☞Once samples has been developed, proceed 

immediately to the next step to prevent the test 

strips from drying out.  

 

 

①② 

Fig.3-(a) Fig.3-(b) 

Inject 10 µL of Washing solution into the same wells as 

in Step 1. [Fig.3-(a)] 

 ☞Make sure that the washing solution (droplets) falls 

to the bottom of the well.  

 ☞If you use tweezers to lift the test strip and place it 

back into the same well, the water will be developed 

more quickly. [Fig.3-(b)] 

15 min.

later 

Fig.4-(a) Fig.4-(b) 

1. Inject 30 µL of Gold nanoplate labeled antibody 

solution into the same wells as in Steps 1, 2. 

[Fig.4-(a)] 

      ☞ Please refer to the notes in Step 2. 

2. When the Gold nanoplate labeled antibody 

solution is developed, the test line (lower side) 

and control line (upper side) gradually become 

colored.  

[図 4-(b)]  

  
Fig.5 

Add 50 µL of washing solution to each new well. [Fig.５] 

☞ Please refer to the notes in Step 2. 
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 Protocol 

＜Detection Test＞ 

1 Preparation of standard substance solution for positive controls 

① Dissolve each standard substance (rCD9 or rCD63 or CD81 peptide) [lyophilized 

product] by injecting 140 µL of purified water into the tube containing the standard 

substance and mixing with a table-top mixer. 

② After dissolution, dilute each standard 2-fold with Sample diluent, and mix with a 

table-top mixer. (Table 1) 

Table1. Concentration of standard material solution to be prepared 

 

2 Preparation of sample diluents 

Add Dilution solution to your sample solution containing extracellular vesicles so that 

the amount of diluents spread on each immunochromatographic test strip is 20 µL 

(e.g., 5 µL of your sample solution + 15 µL of Dilution solution).  

After dilution, sample diluents are left on ice for 1 hour (to prevent clogging of the 

samples during immunochromatography). 

3 Preparation of Gold nanoplate labeled antibody solution 

Add 220 µL of purified water to the Gold nanoplate labeled antibody (lyophilized 

product) and dissolve by stirring using a tabletop mixer.  

4 Injection of each developing solution and development of the solutions onto 

Immunochromatographic Test Strips 

Inject 20 µL of ①  Dilution solution (blank solution), ②  rCD9 solution of each 

concentration prepared in "1 Preparation of standard substance (rCD9) solution for 

calibration curve", and ③  sample diluents prepared in "2 Preparation of sample 

diluents" into separate wells. 

Remove the Immunochromatographic Test Strip that has been brought to room 

temperature from the aluminum pouch and place it on the paper towels without 

touching the bottom of the test paper. Discard any that have significant peeling. 

Using tweezers, soak the strip vertically into the wells into which the above solutions 

have been poured, allowing each solution to developed into the 

Immunochromatographic Test Strip※6 (time required: about 10 minutes). 

5 Washing of Immunochromatographic Test Strips 

After confirming that each solution has been fully developed, inject 10 µL of Washing 

solution into the same well and re-soak the Immunochromatographic Test Strip (time 

required: about 5 minutes). 

  

Standard substance
Purified water

(μL)

concentration of ①

(ng/20μL)

concentration of ②

(ng/20μL)

rCD9 140 15 7.5

rCD63 140 40 20

CD81 Peptide 140 4.0 2.0
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6 Development of Gold nanoplate labeled antibodies 

Add 30 µL of Gold nanoplate labeled antibody solution to the same well and re-soak 

the Immunochromatographic Test Strip.  

At this stage, the test line and control line will turn blue (time required: about 15 

minutes). 

7 Washing of Immunochromatographic Test Strips 

Inject 50 µL of Washing solution into an unused well and soak the 

Immunochromatographic Test strip in the Washing solution for 15 minutes.  

8 Quantification of extracellular vesicles in samples 

The intensity of the test line is measured using ① CMS ※ 7, ② ImageJ ※ 8, ③ an 

immunochromatographic measuring device, etc. 

※6. Standard substance can only be detected on the same type of antibody-coated test strips. 

※7. Abbreviation for Color Management System released by TOPPAN Corporation. [Currently under 

consideration for implementation] 

（Release article：https://www.holdings.toppan.com/ja/news/2024/02/newsrelease240227_1.html ） 

※8. See the next page for the analysis method using ImageJ.  

https://www.holdings.toppan.com/ja/news/2024/02/newsrelease240227_1.html
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＜Analysis method  Example: stainintg inrtensity measurement using ImageJ＞ 

1 Photographing the test strip 

After samples are spread, the test paper is photographed with a digital camera or 

scanner, and the image data is saved in JPEG format. 

☞ It will be easier to photograph it if you attach it to a mount or similar before 

photographing it.   

2 Preparation of ImageJ 

① Download 

Download the public domain image processing software "Image J" from the following 

URL.  

URL：https://imagej.net/ij/ (As of July 22, 2024) 

Select "ImageJ" from the downloaded file set and launch it.  

For detailed basic operations, please refer to the following URL.   

URL：https://imagej. nih. gov/ij/docs/guide/user-guide. pdf(As of July 22, 2024) 

② Setup 

Select the “Analyze” tab → “Set Measurements” and check “Area” and “Mean grey 

value”.  

 

 
Fig.6-(a) Fig.6-(b) 

https://imagej.net/ij/
https://imagej.nih.gov/ij/docs/guide/user-guide.pdf
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3 Loading test strips image 

Select the “File” tab → “Open” to load the image file. 

Images in formats other than JPEG may not be analyzed correctly, so convert them 

to JPEG before use. 

 
Fig. 7 

 

4 ROI Manager を開く 

Select the Rectangle ROI (rectangle area selection tool) from the toolbar.  

Open “Analyze” tab → “Tools” → “ROI Manager”.   

  

☞ Magnifier tool 

 
Click on the  tool to zoom the image. 

☞ Scroll tool 

 
To move the image in the window, select this tool and move it. 

※If you want to continue the analysis after using the above tools, please 

select a new rectangular ROI first.  

 

 
Fig.8 

Rectangle ROI 
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5 Test line, background staining intensity measurement 

① Enter test line information 

Draw a rectangle around the test line area※7 in the image and type "T" on the 

keyboard to enter the information about the area into the ROI Manager.   

② Enter background information 

Drag and drop a rectangle of the same area as the test line area to select the 

uncolored part of the test paper, and enter the background area information into 

the ROI Manager using the same procedure as in ①.   

Repeat steps ① and ② above for all test strips to be analyzed.  

Check "Show All" and "Labels" to display the selection area and numbers on the image, 

and check that the selection area and order are correct.  

※9.  If the amount detected is small, the center of the test line may be faint, but this does not 

affect the quality. 

※10. Detection lines may also appear in the Blank test. There is no quality problem. 

6 Detection strength calculation 

 Select the information entered in the ROI Manager in the previous section, and click 

"Measure" in the ROI Manager window. The Results window will open and the average 

luminance (Mean) of the area enclosed in a rectangle will be displayed. Select all of 

these, paste them into Excel, and subtract the "Mean" of the test line from the "Mean" 

of the background to calculate the staining intensity (detection intensity).  

 Contact 

Dai Nippon Toryo Company,Limited 

SPECIALITY BUSINESS DIV. NEW BUSINESS DEVELOPMENT DEPT.  

E-mail：evs-support@star.dnt.co.jp 

Fig.10-(a) Fig.10-(b) 
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Fig.9-(a) Fig.9-(b) 


